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Read this manual before using the products, and keep it handy.  
This manual explains you how to install the software and to use it.  
This manual is saved into the software installation CD-R as a PDF file, which can be opened by using the Acrobat 
Reader.  You can download the Acrobat Reader at the home page of Adobe Systems at the following URL; 
http://www.adobe.com/ 
 
DISCLAIMER 
TEAC CORPORATION (“TEAC”) disclaims all warranty, either expressed or implied, with respect to this product and the 
accompanying written materials.  In no event shall TEAC be liable for any damages whatsoever (including, without 
limitation, damages for loss of business profits, business interruption, loss of business information or other loss) 
arising out of the use of or inability to use this product. 
 
z The names of products that appear in this document are registered trademarks of the respective holders. 
z Specifications are subject to change without notice.  
 
May 2006   Revision 1.48  
 
Scope of Manual 
This LX View users’ manual covers explanations how to use the LX View PL-S1001 basic software and other optional 
plug-in software to the LX View.  
 

PL-S1001 Wave Monitor LX View Basic software 
PL-S1002 Advanced File Converter  

AFC NEO 
It is a file converter software part already plug-in to 
the PL-S1001.  The software is also available as a 
stand-alone package. 

PL-S1003 LX Playback Optional software, PC file playback function by using 
the LX series recorder. 

 
Customer who purchased a stand-alone AFC NEO PL-S1002: 
Refer “4.2.1. Data File Conversion of LX/GX-1/es8 Series”  
 
Customer who purchased an optional plug-in LX Playback PL-S1003: 
Refer “Chapter 6 LX Playback Software”. 
 
Customer who purchased AFC NEO + CAN PL-S1002CAN: 
Refer “Chapter 7 AFC NEO + CAN Software.  
 

 



Revision History 
Revision Date Description 

1.38b November 2003  

1.48 September 2005 Applicable for the LX View Version 1.48 or later 

1.48 May 2006 Changing description because of merged by TEAC 
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LICENSE AGREEMENT AND LIMITED WARRANTY 
 
IMPORTANT: 
PLEASE CAREFULLY READ THE LICENSE AGREEMENT HEREIN BEFORE USING THE SOFTWARE. THE RIGHT TO USE THE SOFTWARE IS 
GRANTED ONLY ON THE CONDITION THAT YOU AGREE TO THE LICENSE AGREEMENT. IN CASE YOU DO NOT AGREE TO THE LICENSE 
AGREEMENT, DO NOT INSTALL THE SOFTWARE. IF YOU HAVE ALREADY INSTALLED THE SOFTWARE, STOP THE USE AND UNINSTALL 
THE SOFTWARE. IF YOU DO NOT AGREE TO THE LICENSE AGREEMENT, YOU MAY RETURN THE PACKAGE FOR A REFUND. 
UNAUTHORIZED REPRODUCTION OR DISTRIBUTION OF THE SOFTWARE, OR ANY PORTION OF IT, MAY RESULT IN SEVERE CIVIL AND 
CRIMINAL PENALTIES, AND WILL BE PROSECUTED TO THE MAXIMUM EXTENT POSSIBLE UNDER LAW. 

 
This License Agreement with limited warranty is a legal agreement between you (either an individual or a single entity) and TEAC 
Corporation ("TEAC") for the SOFTWARE, which includes computer software and electronic documentation. 
 
1. GRANT OF LICENSE. 
TEAC grants to you the right to use one copy of the SOFTWARE in a single computer.  The SOFTWARE is in "use" on a computer when it 
is loaded into temporary memory (i.e., RAM) or installed into permanent memory (i.e. hard disk or other storage device) of the computer. 
However, installation on a network server for the sole purpose of distribution to one or more other computer(s) shall not constitute "use" 
for which a separate license is required.  
 
2. COPYRIGHT. 
All title and copyrights in and to the SOFTWARE and any copies thereof are owned by TEAC or a supplier to TEAC. 
The SOFTWARE is protected by Japanese copyright laws, international treaty provisions, and all other applicable national laws. 
 
3. RESTRICTIONS. 
You may not distribute copies of the SOFTWARE to third parties. 
You may not reverse engineer, decompile, or disassemble the SOFTWARE, except and only to the extent that applicable law 
notwithstanding this limitation expressly permits such activity. 
You may not rent or lease the SOFTWARE. 
You may not reproduce the SOFTWARE except for archival purpose. 
 
4. TERMINATION. 
Your rights under this Agreement terminate upon the disposal of all copies of the SOFTWARE, or without prejudice to any other rights, 
TEAC may terminate this Agreement if you fail to comply with the terms and conditions of this Agreement. In such event, you must destroy 
all copies of the SOFTWARE. 
 
5. LIMITED WARRANTY. 
TEAC warrants that the SOFTWARE will be usable for the purpose expressed on TEAC's document when properly installed on a computer. 
TEAC does not warrant that the operation of the SOFTWARE will be uninterrupted or error free, and that the SOFTWARE is fit for any 
particular purpose. 
 
6. NO LIABILITY FOR CONSEQUENTIAL DAMAGES. 
TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL TEAC BE LIABLE FOR ANY SPECIAL INCIDENTAL, 
INDIRECT, OR CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS 
PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR ANY OTHER PECUNIARY LOSS) ARISING OUT OF THE USE 
OF OR INABILITY TO USE THE SOFTWARE, EVEN IF TEAC HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  BECAUSE 
SOME STATES AND JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR 
INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU. 
 
7. MISCELLANEOUS. 
This agreement is governed by the laws of Japan. 
Should you have any questions concerning this Agreement, or if you desire to contact TEAC for any reason, please write to the address set 
forth below: 
 
TEAC CORPORATION 
3-7-3 Naka-cho, Musashino-shi, 
Tokyo 180-8550, Japan 
E-mail: tic_cs@teac.co.jp 
Fax:+81-422-52-1990 
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Chapter 1 Overview 
 
1.1. Introduction 
The LX View PL-S1001 is a data viewer software to view a data file and to extract a part of the data file by supporting data files recorded 
at TEAC data recorders (*). 
 
z As of May 2006, the LX View supports the data files recorded at the DS series, the LX series, the GX-1 (except for the multi sampling 

data files), and the es8 series 
z Types of supporting file format conversions are different from those of the DS series and those of the LX/GX/es8 series.  Refer to 

“4.2. Converting Data”. 
z The contents of this manual can be applied to the LX View PL-S1001 Version 1.48 or later.  
 
Terminology used in this manual: 
“Key”: A push button on the panel of the main unit. 
“Cursor Display”: An item selected in the display and highlighted (called “cursor”) during the main unit operation.  
<MENU>, <Are you sure?>: A message or dialog shown in the unit display or the PC software. 
[REC]: A control button on the unit display or a selection item on the PC software. 
 

 
1.2. What You Can Do 
z View a bulk data recorded by TEAC data recorders: The program can display a maximum of 128 data channels.  If the 

displayed data channels do not fit into a single PC display, you can see them by using a scroll bar.  It reproduces recorded data of a 
selected data file on a T-Y graph from the start point to the stop point data on a single PC display (*), to browse the trend of the data 
file.  Data plot in overlay is also possible.   (*Depends on the installed memory capacity of your PC.  You can use a horizontal 
scroll bar if the data display does not fit into a single PC display.)  

z Extract data, specify the extracting section by browsing a voice memo waveform: The program lets you specify the data 
points to extract data by using two cursors and it can read maximum, minimum, and difference values between the cursors.  You 
can see the voice memo waveform and then extract by using the cursors by listening to your PC.  The program can display the 
event points and information of the data recorded by the LX series or the GX-1.  

z File conversion on the extracted data: The program converts the extracted data to ASCII that general analysis software can 
import, and other file formats (DADiSP, MATLAB, ATI（IDEAS）, WAV, Universal File (UFF58)、RPC3 and TAFFmat) with decimation if 
necessary.  

z File conversion in batch operation: The program can process a series of pre-registered conversion tasks in batch operation.  You 
can register the series of conversion tasks to a spread sheet list, and you can also save and load them.  

z Processing a waveform data: The program computes the displayed waveform data to FFT and X-Y display. 
z Analog playback of the data file at PC (LX Playback PL-S1003 LX Playback): The program can output the analog signals of the 

LX pre-recorded data file on the PC by using the analog output amp of the LX series.  
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1.3. Important Notice 
Please note the followings on using the software. 
 

 CAUTION 
z The software supports NTFS file format to open and view a bulk data file exceeding 4GB.  
z Depending on the free memory size per the installed memory size (shall be more than 256MB) of your PC, the horizontal scale of 

view area will be specified. 
z There is no limitation on the data file size can be opened except for the memory size.  
z The data file size can be converted shall be 2GB or less. 
z The length of memo voice file can be viewed shall be one hour or less.  
z LX Playback PL-S1003 software has the following limitations on the data file can be played as analog signals.  (1) At the LX 

IEEE1394 interface model for playback, the maximum sampling frequency for playback is 48 kHz, 96 kHz can not be used.  
Combination of 48 kHz x 8 channels is a maximum for playback.  (2) At the LX LAN model for playback, Combination of 6 kHz x 16 
channels is a maximum for playback.  
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Chapter 2 Software Installation, Launching and Closing Software 
 
2.1. Software Installation 
 

 CAUTION 
z The more memory you have, you can view at the wider time scale. 
z Windows sound system to listen to the voice memo. 
z A drive to support the type of the recorded media to reproduce the media. 
z CD-ROM drive or equivalent to run the program installation.  
 
Required PC specifications 
CPU:   Pentium III 450 MHz or more 
OS:  Windows 98SE/Me/2000/XP  
Memory:  256 MB or more 
Free HDD space: 200 MB or more, the PC must have enough hard disk space to load the data file.  
 
The installation software is on the CD.  Follow the generic Windows software installation. 
 

1. Insert the installation CD into the drive of the PC.  The installation program 
automatically starts running.  
 

2. If it does not start, run the “setup.exe” on the Disk 1 LXView folder of the 
installation CD. 
 

3. Follow the messages displayed. 
 

4. The installation automatically adds an icon to your start up menu.  Program 
installation default is ¥Program Files¥Teac¥LXView.exe. 

 
 
2.2. Launching and Closing Software 
Follow the generic Windows software operation to launch and close the application. 

1. Double click the icon on your start up menu. 
<Open> dialog is displayed to select a file to view. 
 

2. <Open> file dialog displayed at the launching software is from the previously 
opened folder. 
 

3. Click       on the top right corner or click [Cancel] button to close <Open> file 
dialog. 
 

4. To close the software, click        on the top right corner of the view window or 
click [File] -> [Exit] on the menu bar after closing <Open> dialog. 
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2.3. Open File to View 
 

 CAUTION 
z The software supports NTFS file format to open and view a bulk data file exceeding 4GB.  
z Depending on the free memory size per the installed memory size (shall be more than 256MB) of your PC, the horizontal scale of 

view area will be specified. 
z There is no limitation on the data file size can be opened except for the memory size.  
 

1. Select a file at <Open> dialog appeared at launching the software or click [File] -> 
[Open...] to display <Open> dialog to select the file.  
 

2. Select the file and click [Open(O)] to display the waveform view window. 
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Chapter 3 Basic Operations at Waveform View Window 
 
3.1. Basic Operations 
The following operations are available at the waveform view window. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Menu bar 
File: Open file, export file (extracting data), print out, etc. 
Edit: Zoom, undo zoom 
View: Set display properties 
Help: Version information 

Open file 

Display the header information of the file being viewed. 

Zoom, undo zoom, release zoom

Export 
Activate RPM monitor

Activate FFT display

Activate X-Y display

Help

Activate the window
to turn ON/OFF each
channel display. 

Extend Y-axis by 
dragging the 
slider to 
downwards 

Click the right edge to change the display horizontal scale
scan: Numbers of scans 
second: Elapsed time (seconds) 
time: Elapsed time 

Time of C1 cursor 

Time of C2 cursor

Time between C1 and C2 cursor

Channel property
Show details of cursor values of
each channel 

Time of extreme right
of the view window

Status bar 
Display the operation
status 

Display the current file name with full path

Display the 
channel 
number 

Show event mark position at event mark number with a vertical line on the graph 

Copy to media 

Tool bar 

Display (even) mark list.  The button is in-active if no event
is recorded at the file being viewed. 

Display the memo voice waveform window.  The button is
in-active if no voice memo is recorded at the file being viewed.

The button is active when optional LX Playback
software is installed. 

Activate Statistics display
Control keys for memo voice
playback.  They become active
when clicking [MEMO] to view the
voice memo waveform. 

Search bar 
Set 
parameters 
to extract 
data 
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3.2. Use Scroll Bar to Expand and to Move View Area 
Move the slider control located at the right edge of the waveform view window downwards to expand Y-axis scale. 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
The size of each scroll bar represents the size of the current display area against the whole data area. 
 
 

3.3. Turn ON/OFF of View Channels 
Click          on the top right corner of the waveform view window to display the channel selection panel to turn ON/OFF of each 
channel display. 
 
 
 

 

 

 

 

 

 

 

 

 

 
Click      again to close the channel selection panel. 
 
 
 

Click each number to turn ON/OFF the correspondent
channel display. (Gray for OFF) 

Drag the slider control downwards to expand whole Y-axis scale.
When all channels cannot be viewed by fitting to a single screen, the
scroll bar will be appeared to move among the channels. 

Click to turn ON all channel
display at once. 

Use the left/right scroll bar to move the time scale.
The scroll bar is not appeared when the data has been fitted into a single screen. 

Click to sort the channel display in ascend order of the channels.

Click to fit all channels to a single screen. 
If all channel display is not fitted to it due to the display resolution of
the PC, the software automatically aligns the display to appear the
up/down scroll bar. 
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3.4. Zoom and Read Data Value by Using Cursors 
Use C1 and C2 cursor to read the data value, and to zoom the view area. 
 
3.4.1. Zoom Time-axis 

1. C1 and C2 cursor are located at the extreme left and right of the waveform view 
window when opening the file. 
 

2. Locate the mouse pointer to the extreme left to change the pointer to <⇔>. 
 

3. Drag the mouse to draw out the C1 cursor and drop at the start zoom point.  
 
 
 
 
 

4. Draw out the C2 cursor as well, to drag and drop at the end zoom point.  
 
 
 
 
 
 
 
 
 
 
 
 
 

5. Click          on the tool bar. 
 

6. Area between cursors will be zoomed. 
 

7. Release the zoom mode to click the following buttons on the tool bar. 
 
      : Returns to previous 
 
 

: Releases zoom 
 
 

3.4.2. Display Cursor Position Data Value 

1. Click         on the bottom of the waveform view window to see the data value 
details by using C1 and C2 cursor. 
 

2. <Wave Parameter> is displayed on the bottom of the window. 
Channel: Displays the channel number. 
Range: Displays the input range setting at recording. 
DispRange(Max)/DispRange(Min): Displays maximu and minimum graph scale value 
in X-axis, which represents as horizontal dot lines.  Maximum and minimum of the 
input range are used as the graph scale default.  They can be specified manually at the 
display range settings of <Channel Property> explained later.  
Cursor(C1)/Cursor(C2) : Data values at C1 and C2 cursor. 
Abs (C1-C2) : Difference between the data values of C1 and C2 cursor. (Absolute value) 
Max (C1-C2) : Maximum data value between C1 and C2 cursor. 
Min (C1-C2) : Minimum data value between C1 and C2 cursor. 
Channel Name: Displays the channel name. 
 
Times of the cursor positions are displayed at the bottom of the window. (Yellow : C1 
time, Green : C2 time, White : Delta-T between C1 and C2) 
 

Area between C1 and C2 cursor can be zoomed.
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3. Dragging the left corner of <Wave Parameter> can locate <Wave Parameter> at 
any position of the waveform view window, such as within, left, or top of the window. 
Drag and drop it the bottom of the window to return it to the original position 
 
 
 
 
 
 
 
 
 
 
 

3.5. Overlay View 
View the channels in the overlay mode.  Multiple channels can be overlaid.  
Use <Channel Property> explained later to change the display maximum and minimum scale of Y-axis of each channel. 
 

1. View the waveform display. 
 
 
 
 
 
 
 
 
 
 
 

2. Drag the channel information section located left of the channel waveform display 
to be overlaid to other channel.  The channel information section being dragged turns 
dark gray. 
 
 
 
 
 
 
 
 
 
 

3. Drop it to other channel to overlay view. 
 
 
 
 
 
 
 
 
 
 
 

4. Channel information section of the overlaid channels is changed to the left shown.  
Click X to release the overlay view.  Click < > to change the overlaid channel turns. 
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3.6. Set Graph View Style and Y-axis Scale (Channel Property) 
Use <Channel Property> to change the graph view style and Y-axis display scale. 
 

1. Click        on the bottom of the waveform view window to display <Wave 
Parameter>. 
 
 
 
 
 
 
 
 
 
 
 

2. Double click the mouse button while the mouse pointer is locating at the channel 
row of <Wave Parameter> to open <Channel Property> of that channel. 
 
 
 
 
 
 
 
 
 

 
Item Description 

channel name Displays the channel name set at recording. 
unit Displays the physical unit set at recording. 
range  

range Displays the slope value set at recording. 
offset Displays the offset value set at recording. 

display range Sets Y-axis display scale. 
max Enters the maximum display scale.  Range maximum value set at recording is used as default. 
min Enters the minimum display scale.  Range minimum value set at recording is used as default. 

same Checks “all” and then click it to apply the entered value here to all other channels. 
auto Checks to display in auto range mode by following the maximum and minimum value of the data. 

reset Resets the graph scale entered to the default set at recording. 
all Apply the settings to all other channels after checking it. 

color Selects the colors of the graph line and the background. 
line Selects the graph line color. 

▾ Click to open the color selection pallet. 
same Apply the color selected to all other channels. 
reset Resets the color to default. 

back Selects the graph background color. 
▾ Click to open the color selection pallet. 

same Apply the color selected to all other channels. 
reset Resets the color to default. 

 

 

3.7. View Menu 
View Menu 
To turn ON/OFF displaying the tool bar and the status bar, click [View] -> [Toolbar], [Statusbar], [Searchbar]. 

 
Click [View] -> [View property] to display <View property> to select either keeping or 
not keeping the display information whenever closing the software.  If you do not want 
to keep it, check the box located at the left of <Reset view information whenever 
importing file>. 
Check the box of <Use Japanese font> to display the Japanese fonts correctly. 
 

 CAUTION 
When you select to keep the display information, the information of the channels to be 
displayed is also kept.  Please note that all channels of a newly opened file will not be 
displayed if the fewer channels have been selected for display. 
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3.8. Browse Contents of Header File 
Click         to browse the contents of the header file. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3.9. Check Software Version 
Click         to check the software version. 
 
 
 
 
 
 
 
 
 
 
 
 
Click [OK] to close the display. 
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Chapter 4 Advanced Operations 
 
4.1. Search 
Set the search conditions to extract the part of the data.  The start and end point can be specified. 

 

1. Use the buttons locating upper part of the waveform view window. 
 
 
 
 
 
 
 
 

2. Click [Info…] to display the search condition dialog for the following settings. 
There is <Relative> check box available at the dialog at Stop to link the conditions set to 
those set at the dialog at Start.  
 
 

 
 
 
 
 
 
 
 
 

Item Description 
Scan Specifies the extracting point with number of scans. 
Counter Specifies the extracting point with the elapsed time from the start recording. 
Time Specifies the extracting point with the absolute time. 
Mark Specifies the extracting point with the (event) mark number. 
Level Trig Extracts the data at a specified signal level change point (level trigger). 

Selects an objective channel and sets a threshold for cross up or cross down. 
Sets the threshold in % or voltage level. 
Sets the pre-trigger points with number of scans or seconds at <Pre Trig>. 

Relative Only for the dialog at Stop: Links to the conditions set at the dialog at Start. 
OK Confirm the entered conditions at the dialog to set for the extracting point. 
CANCEL Cancels the entered conditions to return to previous. 

 

3. Click [Search] to start extracting to view. 
 

 

4.2. Converting Data File 
Click [File] -> [Export...] to display <Export> to convert the data currently being viewed.  The default conversion part is one which is 
currently viewed at the waveform view window.   
In order to convert any part, use the cursor zoom function, or the search function to specify the view part.  
 

 CAUTION 
z Types of supporting file format conversions are different from those of the DS series and those of the LX/GX/es8 series.  
z When newly opening the file to view, the cursors are located at the extreme left and right.  The data in the current view part will be 

converted.  
 
4.2.1. Converting Data File Recorded at LX/GX-1/es8 Series 
Activate “PL-S1002 AFC NEO” when the data file recorded at LX/GX-1/es8 series is selected. 
When you are using PL-S1002 only, the software does not have any data view function and opens the dialog by executing [AFCNEO.EXE].

Click to set the start point of data
extraction.

Click to set the end point of data
extraction.

Click to start data extraction.
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 CAUTION 
z Use only alphanumeric characters allowed for Windows for a file name and a folder name, do not use Japanese characters. 
z The data file size can be converted shall be 2GB or less. 
 

1. View the data part to be converted by using the cursor zoom function or the search 
function. 
 

2. Click [File] -> [Export...] on the menu bar or        on the tool bar. 
 

3. <AFC NEO> is displayed. 
While displaying <AFC NEO>, the waveform view window will be disappeared once, 
however; it will be appeared automatically when closing <AFC NEO>. 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Item Description 
Original file Displays the file to be converted with a full path.  Click [Ref...] to select the data folder. 
Output file Click [Ref...] to set the folder and the file name to save the converted data file. 
From Displays the data conversion start point with number of scans.  Enter the number manually or use the slider control to change the 

start point number. 
to Displays the data conversion end point with number of scans.  Enter the number manually or use the slider control to change the 

start point number. 
Skip Enters a data decimation parameter.  For example, enter [10] if you want decimate the data each one out of 10 scans.  <1/1> 

will be shown if you select the data file format not supported decimation.  
Format type of 
output file 

Selects a file format to convert.  If you select the file format other than one selected at <Output file> -> <Set Output File> <Type 
of File (T)>, the file extension specified at <Output file> is used.  

Channel of original 
file 

<Channel of original file> displays the channels of the original file.  Enter or remove the channel(s) to convert by using [Add all], 
[ADD>>], [<<DEL], [Delete all]. 

Channel of output 
file 

At the default view, it displays all the channels of the original file at <Channel of original file>.  Click the channel and [ADD>>] to 
enter to <Channel of output file> from <Channel of original file>, click the channel and [<<DELL] to delete.  Check [Add all] to 
enter all channels to <Channel of output file> and check [Delete all] to delete them.  The channels displayed at <Channel of 
output file> are those selected at the channel selection panel.  

EXIT Closes the dialog. 
CONVERT Starts converting the selected data part.  <Now converting...> will be shown while conversion.  Click [STOP] to terminate 

conversion.  
BATCH Displays the batch processing menu explained later. 

 

4. Click [Ref...] of <Output File> to display <Set Output File>. 
Set a directory name, a file name, and a type of the file to convert. 
Enter the start ID number at <Start ID Number> to attach to the last of the file name 
entered, and enter the number of digits of ID number at <ID Digits>.  
<TESTLX01.dat> will be created at this example. 
The start ID number and the number of digits will be useful at the batch processing 
explained later. 
The file extension selected at <Format type of output file> is used.  
 
 

5. Set the necessary items at <Set Output File>, and then click [Save(S)] to confirm 
the file name settings.  
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6. Set other parameters at <AFC NEO>, if necessary. 
 

7. Click [CONVERT] to start the file conversion. 
The processing status of the file conversion is displayed at <Progress bar> on the left of 
[STOP].  Click [STOP] to suspend the conversion.  
 
 
 
 
 
 
 
Merge Data Files 
Merge the data files recorded by using the synchronizing recording function of the LX 
series and the GX series to create a single data file.  
 

 CAUTION 
z 128 channels on a single file is a maximum number of channels for the merge 

result. 
z At the merge case of the data files recorded at the LX series, the tachometer data 

channel is treated as data channel, if it sets to ON.  One tachometer data 
channel of 16 bits mode will be counted as one channel, one tachometer data 
channel of 32 bits mode will be counted as two channels.  

z The part of the slave data file to be merged follows where the master data file is 
displayed.  

z The merge function does not support individually selected channels.  
 

1. Display the master data file. 
 
 

2. Select and click [Merge] at <Format type of output file> of <AFC NEO> to display 
the slave file selection under <Original file>. 
 
 

 

 

 

 

3. Click [Ref…] located the right of the file selection displayed to display <Select File>. 
 

4. Select the slave file at <Select File>, and then click [Open(O)]. 
 

5. The selected slave file is displayed at the file selection.  

 

6. Follow the same procedures of the file conversion to execute the file merge.  

 

 
Batch Processing of File Conversion 
Enter the sequence of the file conversions to convert the multiple files at a time.  
 

1. Click [BATCH] of <AFC NEO>. 
 

2. The batch processing window will be appeared under the file conversion menu.  
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3. Set a file to convert by following the file conversion procedures explained previously, 
and then click [ADD] to enter the current conversion parameters.  
 
 

4. You can see the following fields by moving the slider control at the bottom of the 
batch processing window:  
name Name of  <Original file> to be converted 
format File format selected at <Format type of output file> 
ch Channels of the file to convert, being displayed separately by slash symbol 
start Start scan number at <from> 
end End scan number at <to> 
skip Number of decimation at <Skip> 
output Name of <Output file> to convert 
status Shows the progress status of conversion in percentages 
 

5. Continually, set the file to convert, and then click [ADD] to enter the conversion 
parameters until you complete the entry of the files to convert.  
 

6. Move the cursor to highlight the file entered, and click [DELETE] to remove it from 
the entry.  The file entered with the check mark removed in the box next to the file 
name will not be processed to convert. 
 
 

7. Click [ADD MULTI] to display <Select Files>.  Multiple files to be converted can be 
selected by using the standard Windows key operations (Shift key + Arrow key, or Ctrl 
key + right click).  Check [ALL Channels] and [All Data] to make all channels of all 
selected files to the targets for conversion.  Click [Open(O)] to confirm the entry.  
 
 
 
 
 
 
 

8. Incremental ID numbers to the file name entered at <Set Output File> will be given 
in the sequence of the file selections.  
 
 
 
 
 
 
 
 
 
 
 
 

9. Click [START] to start the file conversion in batch mode. 
[status] shows the progress status of conversion in percentages. 
Click [STOP] to suspend the file conversion. 
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You can save and load the entered file conversion parameters as a parameter file. 
Edit the saved parameter file to easily modify the parameters by using a text editor, and 
load it to change the file conversion procedures.  
 
Save the entered parameters 
Click [SAVE] to display <Save by changing the file name> dialog to put a file name to be 
saved.  The file extension is fixed at <prm>. 
 
Load the entered parameters 
Click [LOAD] to display <Open file> dialog to load the parameter file previously saved.  
 

 

 

 

 

 

 

 
View the contents of entered parameters 
The parameter file shows the entered parameters with texts and comma separated.  

 
Parameter file example 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
4.2.2. Converting Data File Recorded at DS Series 
<Export> will be automatically activated to convert the data file recorded at the DS series. 
 

 CAUTION 
z The file type of the target file to convert can be either TAFFmat or Text. 
z Use only alphanumeric characters allowed for Windows for a file name and a folder name, do not use Japanese characters. 
z The data file size can be converted shall be 2GB or less.  
 

1. View the data part to be converted by using the cursor zoom function or the search 
function. 
 

2. Click [File] -> [Export...] on the menu bar, or click       on the tool bar. 
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3. <Export> is displayed. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

Item Description 
Span Selects the part of the data file to be converted with <from> and <to>. 

from Displays the data conversion start point of data conversion.  Enter the number manually to change the point. 
Click [scan] to change to [sec] to set the point in seconds, or reverse to set the point in numbers of scans.  

to Displays the data conversion end point of data conversion.  Enter the number manually to change the point. 
Click [scan] to change to [sec] to set the point in seconds, or reverse to set the point in numbers of scans.  

scan Each click to toggle between [scan] and [sec] to set the start and stop point in either numbers of scans or seconds.  
skip Enter a data decimation parameter.  For example, enter [10] if you want decimate the data each one out of 10 scans.  

Channel The left filed shows the channels of the original file to be converted.  The right field shows the channel to be selected for the file 
to convert.  Enter or remove the channel(s) to convert by using [Add all], [ADD>>], [<<DEL], [Delete all].  

Output Click [Ref...] to set the folder and the file name to save the converted data file. 
Slave Use it to merge the data files recorded at the synchronization recording mode of the DS series. 

Check the box, and click [...] in the right to select the slave data file to be merged. 
OK Starts converting the selected data part.  <Now converting...> will be shown while conversion.  Click [STOP] to terminate 

conversion. 
CANCEL Closes the dialog without conversion. 

 
 

 CAUTION 
About merging data of the DS series 
z You can merge data files to a single file recorded by the synchronization recording function of two sets of the DS units.  (As of 

August 2003)  
z Maximum channel number for the merged data file is 128.  
z The part of the slave data file to be merged follows where the master data file is displayed.  
z The merge function does not support individually selected channels.  
 

 

4.3. Extracting Data with Voice Memo Playback 
You can play the voice memo recorded by using the LX series in order to specify the data part to extract.  
 
Example: Browse the recorded data file associated with the voice memo in your Windows explorer. 
The voice memo file has the same file name with the data file and the header file. 
*.dat Data file 
*.hdr Header file 
*.wav Voice memo file 
 
 

 

 

 

 

 

 

 

 

 



LX View User’s Manual 
Chapter 4 Advanced Operations 

Page 17 

 CAUTION 
Voice memo files to use this function must be shorter than one hour of recordings. 
 

1. Open the data file containing the voice memo file. 
 

2. Click [View] -> [Memobar], or click          on the tool bar. 
 
If the data file does not have the voice memo file, you cannot operate it. 
 

3. The waveform of the voice memo file will be displayed at the bottom of the 
display(Voice memo waveform window). 
 
 
 
 
 
 
 

 

 

 

 

4. Select the zoom view section on the waveform of the voice memo file by using the 
cursors located at the extreme left and right.  Move a mouse to the cursor position at 
the extreme left to see the cursor pointer change to <⇔>.  Use the left button to drag 
the cursor line to the position of the zoom start point (the left edge).  Use the same 
mouse operation on the cursor located at the extreme right to move the cursor line to 
the zoom end point (the right edge). 
 

 

 

 

 

 

 

 

5. Click         to listen to the voice memo on the specified part by using the 
cursors.  The current playback point can be shown in highlight.  Listen to the voice 
memo to check. 
 

 

 

 

 

 

 

6. Click one of the control buttons on the tool bar to stop, play or pause playback. 
Stop, Play, and Pause from left to right.  Release the pause state to click Pause again. 
 
 

 

 

7. Click        to locate the data point of the current pause position to the left edge 
the waveform data display.  
 

8. Click        on the tool bar to zoom the waveform data display to specify the data 
extracting part according to the current part between two cursors of the voice memo 
waveform. 
 

9. Click        again to close the window. 
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4.4. Move to Event Mark Position by Showing Event Mark List 
You can see a list of events if the event marks are recorded and can zoom the part between the event marks.  
 

 CAUTION 
No event mark information is recorded at the file recorded by the PC direct recording of the LX series. 
 

1. Open the file recorded the event marks.  Each event number and its position will 
be displayed on the top of the wave form data display. 
 

2. Click [View] -> [Markbar] or click           on the tool bar. 
 
If the data file has no event mark, you cannot operate it. 
 

3. The list of the event mark numbers and corresponding numbers of scans is 
displayed on the left of the waveform window. 
 
 
 
 
 
 
 
 
 
 
 

4. Locate the mouse pointer to change to <⇔> at a separation line between the event 
mark list and the waveform data display.  Drag the pointer to the right to widen the 
event mark list area to see <COUNTER> and <TIME>. 
 
 
 
 
 
 
 
 
 
 
 

5. Double click the event number on the list to zoom the waveform display to the next 
event number.  You can see the clicked event number data at the extreme left of the 
wave form display and the next event number data at the extreme right of the wave 
form display. 
 

6. Click         again to close the list. 
 
 

4.5. Copy Data to Media 
You can use the copy function to extract the data and copy it to the media which the LX main unit can playback.  
 

 CAUTION 
z No event mark information is recorded at the file recorded by the PC direct recording of the LX series. 
z To create the media playback on the LX main unit, specify the number of channels to be copied within 2, 4, 8, or 8 x according to the 

analog output channels of the LX main unit to be used.  The channel number is automatically selected in ascending order from the 
channels extracted.  

z This function does not support the low speed sampling frequencies of the LX series.  
z The data file recorded other than 96 kHz sampling series of the LX-20 can not played back at the LX-10. 
z The function only supports the data file recorded at the LX series. 
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1. Click          on the tool bar. 
 

2. <LX Copy> is displayed. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Item Description 
Original Name Indicates the directory name and the file name of the displayed data in a full path.  Click […] on the right to change.  
Span Enters the copy start point to <from> and the copy end point to <to>. 

from Displays the copy start point.  You can manually enter the point to change. 
Click [scan] to change the display to [sec], to set the point either numbers of scans or seconds.  

to Displays the copy end point.  You can manually enter the point to change. 
Click [scan] to change the display to [sec], to set the point either numbers of scans or seconds.  

scan Each click to toggle the display between [scan] and [sec] to specify the point by using either numbers of scans or seconds. 
Sample Displays the sampling rate of the data file.  You can change the sampling rate within the same sampling frequency series when 

creating the copy file.  Refer to the LX main unit instruction manual on the sampling frequency series you can select.  
Channel In the left, the channels of the source file are displayed.  Enter or remove the necessary channels for the copy target file by using 

[Add], [Add All], [Del], or [Del All}. 
Output Sets the copy target file name and the folder name to save by clicking [...] on the right.  

Device Indicates the root directory name of the copy target media. (MO or PC card in your PC)  
Directory Enter the directory name to be used for the data file copy.  The root directory named TEAC_LX is automatically created.  The 

directory you enter is created under the TEAC_LX root directory.  
File Enter the copy target file name.  You can use only up to 8 alphanumeric characters with the extension “.dat” for the file name.

OK Stars data copy of the specified part. 
CANCEL Close the dialog without copy operation. 
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Note: 
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Chapter 5 View Analyzed Data 
You can see the FFT, X-Y view, or other analyzed results of the waveform display data by clicking the corresponding icons on the menu bar. 

 

5.1. View FFT 
You can see the FFT view of the waveform display data.  This FFT will be valid to the data part of the current displaying waveform.  

1. Click           on the tool bar. 
 

2. <FFT Setup> is displayed.  Select each FFT parameter from the pull down list. 
 

Item Description 
Spectrum Select the type of the FFTs 

Power/Linear/RMS/PSD(Power Spectrum Density)/ASD(Linear Spectrum 
Density) 

Line Specify the resolution of the frequency axis. 
256/512/1024/2048/4096/8192/16386/32768  

Overlap Select the overlap. 
0%/25%/50%/75% 

Window Select the window function. 
Rectangular/Hanning/Hamming/Kaiser-Bessel/Flat Top 

Average Select the averaging method. 
No/Linear/Exponential/Max 

 If the bottom box for average indicates “0”, change the combinations of the 
selected parameters.  It is calculating if there are enough existing data 
points to implement the selected Line/Overlap parameters. 

 

3. Click [OK] of <FFT Setup>. 
  

4. The FFT result of each channel will be displayed. 
 
 
 
 

 

 
 
 
 
 
 
 
Click        to change the FFT parameter while displaying. 
 

5. Use the cursors located both extreme left and right of the display by moving to a 
point to read the peak value.  Move the mouse to the cursor position at the extreme 
left to see the cursor pointer change to <⇔>.  Use the left button to drag the C1 
cursor line to the position of the peak point for which you want to read its value.  Use 
the same mouse operation for the cursor located at the extreme right to move the C2 
cursor line to the peak point.  
 

6. Click the channel property button           to display values of the C1 cursor and 
the C2 cursor point. 
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7. Double click your mouse cursor at a row of channel information for which you want 
to change the display scales.  This will open <Channel Property>.  
 
 
 
 
 
 
 
 
 

 
Item Description 

Channel name Displays the channel name at recording. 
Unit Displays the physical unit at recording. 
x axis/y axis Sets the X and Y-axis scale information. 

Lin Displays at a linear scale. 
Log Displays at a log scale. 
Min Enter a minimum value for the display scale. 
Max Enter a maximum value for the display scale. 

Reset Sets to the default value. 
DC Cut Eliminate the DC component from the display. 

Same Click to apply the current settings to all other channels. 
Color Selects the graph line and back ground color. 
Line Sets the graph line color. 

▾ Click to open the color pallet to select the display color. 
Same Apply the current color to all other channels. 
Reset Sets to the default color. 

Back Sets the back ground line color. 
▾ Click to open the color pallet to select the display color. 

Same Apply the current color to all other channels. 
Reset Sets to the default color. 

 

8. Click [View] -> [1 Wave Monitor] on the menu bar to switch to the waveform 
display.  Click [View] -> [2 FFT Monitor] at the waveform display to return to the FFT.  
 

9. To close the FFT display, click [X] on the top right corner of the FFT display. 
 
 

5.2. View X-Y Graph 
You can select two channels out of the waveform display channels to see their X-Y graph.  

1. Click         on the tool bar. 
 

2. <XY Setup> is displayed.  Select the parameters. 
 

Item Description 
x axis/y axis  

ch Select the channels for X-Y view from the pull down menu. 
max Enter the maximum value for the display scale. 
min Enter the minimum value for the display scale. 

Misc  
type Plot type, fixed to [point]. 

signal Select the plot color. 
back Select the back ground color of the X-Y graph.  

 

3. Click [OK] of <XY Setup>. 
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4. The X-Y graph is displayed. 
 
 
 

 

 

 

 
 
 
 
 
 
Click         to change the display parameter during displaying. 
 

5. To read the value of a plot data, use the vertical cursor located at the extreme left 
and the horizontal cursor located at the extreme top.  Cross two cursors at the plot 
data you want to read its value.  Move the mouse to the cursor position at the extreme 
left/top to see the cursor pointer change to <⇔>.  Use the left button to drag the 
cursor line to the position of the point you want to read its value.  The cross point 
values are displayed at the left bottom of the window.  
 
 

 

 

 

 

 

 

 

 

6. Click [View] -> [1 Wave Monitor] on the menu bar to switch to the waveform 
display. Click [View] -> [2 XY Monitor] at the waveform display to return to the X-Y 
graph.  
 

7. To close the X-Y graph, click [X] on the top right corner of the X-Y graph display.  
 
 

5.3. View Statistical Data 
You can see the statistical data (Maximum, Minimum, Average, and RMS) of the displayed segment.  

1. Click          on the tool bar. 
 

2. <Statistics> is displayed. 
 

3. Click [Save] to output the displayed statistical data as a “csv” file.  
 
 
 

 

 

 
 
 

4. Click [Exit] to close the display. 
 

Indicates the cursor cross point values.
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5.4. View RPM Value 
You can see the cursor position data of the selected single channel as RPM (Rotations Per Minute). 

1. Click           on the tool bar. 
 
 

2. <RPM Monitor> is displayed. 
 

Item Description 
CAL RPM Click to calculate RPM value. 
Channel 
Selection 

Selects the channel to display its RPM value. 

Cross Up Selects to RPM pulse detection at rising edge.  
Cross Down Selects to RPM pulse detection at falling edge. 
Threshold 
Level 

Specifies the threshold level to detect the RPM pulse.  

Pulse per Rev. Enter number of pulses per revolution. 
Average Enter number of averaging pulses. 

 

3. Click [CAL RPM] to display the RPM value of the current C1 position based on the 
calculation over the current displayed part.  

 
 
 
 

 

 

 
 
 
 
 

4. Move the C1 cursor with dragging the mouse to read the RPM values of each cursor 
position.  
 

5. Click         on the tool bar again to close the display. 
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Chapter 6 LX Playback Software 
The LX Playback PL-S1003 software is one of the optional applications for the LX View, which enables you to play the LX data file on the PC 
by using the LX unit with an analog output amplifier card.  You need the PL-S1001 LX View to operate the LX Playback. 
 
 

 CAUTION 
z LX Playback PL-S1003 software has the following limitations on the data file can be played as analog signals.  (1) At the LX 

IEEE1394 interface model for playback, the maximum sampling frequency for playback is 48 kHz, 96 kHz can not be used.  
Combination of 48 kHz x 8 channels is a maximum for playback.  (2) At the LX LAN model for playback, Combination of 6 kHz x 16 
channels is a maximum for playback. 

z To playback by removing numbers of the channels of the original file, specify the number of channels to be played within 2, 4, 8, or 
8 x according to the analog output channels of the LX main unit to be used.  The channel number is automatically selected in 
ascending order from the channels extracted.  

z This function does not support the low speed sampling frequencies of the LX series.  
z The data file recorded other than 96 kHz sampling series of the LX-20 can not played back at the LX-10. 
z Playback is possible for the data displayed. A start point of playback is the extreme left of the display and an end point of playback 

is the end of the data file.  
z Playback is possible on the data file recorded 2/4/8/16/32 channels.  If other numbers of the channels are displayed, the playback 

is not possible. 
z The LX main unit to be used must be installed the analog output amplifier(s) needed for the selected numbers of the channels.  
 
6.1. Software Installation 
Required PC specifications 
CPU:   Pentium III 450 MHz or more 
OS:  Windows 98SE/Me/2000/XP  
Memory:  256 MB or more 
Free HDD space: 200 MB or more, the PC must have enough hard disk space to load the data file.  
 
The installation software is on the CD.  Follow the generic Windows software installation. 
 

1. Insert the installation CD into the drive of the PC.  The installation program 
automatically starts running.  
 

2. If it does not start, run the “LXSetup.exe” on the installation CD. 
 

3. Select the interface type (IEEE1394 or Ethernet) of the LX main unit to be 
connected by clicking the interface icon to select the setup program.  And then, click 
[Install]. 
 

4. Follow the messages displayed. 
 

5. The installation automatically adds an icon to your start up menu.  Program 
installation default is ¥Program Files¥Teac. 
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6.2. Operations of Analog Playback 
Connect the LX unit with the analog output amplifier card to the PC with the installed software. 
Check the correct operation of the LX Navi by following the LX instruction manual.  

1. Run the LX View to display the data file to be played back in analog format. 
 

2. Click         on the tool bar. 
 

3. <LX Playback> is displayed. 
 

 

 

 

 

 

 

 

 

 
 
 

4. Click          on the <LX Playback> to open the communication to the LX unit.  
 
 

5. The following example is based on the LAN version of the LX unit. 
Check the box left to <serial> of the LX unit to be connected, and then click [OK].  
 
 
 
 
 

 

 

 

 
 
 
 

6. When the communication starts,  the button           will change to     
on <LX Playback>. 
 
 
 
 
 
 
 
 

7. The standby button           turns red. 
 
 

8. Click           to specify the playback parameters (sampling rate, output range, 
etc.). 
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9. The parameter setting panel is displayed at the bottom of <LX Playback>. 
 

Item Description 
Sample Select the sampling rate for playback. 

Check one of the series of the sampling rate at left, and select the sampling 
rate by using the slider control.  Sampling rate to be displayed is changed by 
following the slider control.  

Monitor Select the monitor output channel and the output voltage range. 
At the monitor section, the left slider control is for selecting the monitor 
output channel. 
The right slider control is for selecting the monitor output voltage range (0.1 V 
steps from 1 V to 5 V).  

 

 

 

 

 

 
 
 

10. While selecting the sampling rate, the message of <Selected upload mode to 
memory> may appear.  It indicates that the playback of the selected sampling rate 
requires transferring the playback data to the LX buffer memory.  In this case, the time 
to the playback standby state (explained later) will take longer than the scenario of 
selecting the sampling rate without a message.  
 
 
 
 
 

 

 

 

 

 

 

 
 

11. Check <Clock> to display the date and time to indicate the recorded start date 
and time on the header file of the selected playback file.  
In this example, the recorded start date and time is 14:37:50 of 2003/6/11. 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

12. Select the output voltage range of each channel. 
The buttons located at the center of the dialog indicates the status of the installed 
analog amplifiers.  
Click the button indicated as [OUT]. 
In this example, the analog output amplifier is installed at the second slot of the LX unit. 
Next to [LX20], each button indicates the first slot of the LX, the second slot, the first 
slot of the expansion unit, and the second slot of the expansion unit from left to right.  
 



 

Page 28 

13. Click the [OUT] button of the correspondent slot to be set to display the output 
voltage setting menu of the selected channels.  
Channel numbers are displayed in ascending order from left to right. 
Select the output voltage (0.1 V steps from 1 V to 5 V) by using the slider control. 
Use the slider control at right to jump to the other slot installed in the analog output 
amplifier card.  
 
Click [LX20] to go to the sampling rate setting panel. 
 
 
 
 
 
 

 

 

 

14. Click [OK] to complete the settings.  Click [X] to cancel the settings. 
Return to the <LX Playback> dialog.  
 
 

15. Click          to go to the playback standby mode. 
The following is displayed while ready for standby. 
The progress bar indicates the status of transferring the playback data to the LX buffer 
memory. 
 
 

 

 
 

16. Upon completion of the data transfer to the data buffer of the LX and stand by, 
the following buttons are valid. 
 
The stop button            and the play button          are valid. 
 
 
 
 
 

17. Click the play button          to start playback. 
 
 
 

18. The playback point is displayed at the D1 cursor. 
Show the counter value (elapsed time) of the playback point at the digital panel of <LX 
Playback> when checking <Count>. 
 
 

 

 

 
From left to right, Mark: 3 digits, Elapsed time:  Date (3 digits), Hour (2 digits), Minute 
(2 digits), and Second (2 digits).  
 
 

 

 

 

 

The playback point is displayed at the D1 cursor. 
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19. While playback, 
 
Click          to pause playback. 
 
 
 
Click          to restart playback. 
 
 
Click           to stop playback. 
 
 

20. Check <Clock> to display the date and time. 
 
 
 

 

 

 

 

 

 

 

 
 

21. Check <Repeat> to repeat playback of the segment from the start point of the 
display to the end point of the file. 
When repeating playback, the playback starts immediately after the playback standby is 
ready without clicking the play button.  
 

22. To close <LX Playback>, click [X] at the top right corner. 
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Note: 
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Chapter 7 AFC NEO + CAN Software 
 
Use the AFC NEO + CAN PL-S1002CAN software for the data file recorded at the GX-1 CAN series. 
You can extract the CAN packet data recorded to convert to the physical value to align sampling data of the analog signals with 
correspondent to the CAN database (CANdb).  
 

 CAUTION 
z Do not use two byte codes for the folder name and the file name.  Use the alphanumeric characters allowed to use with Windows.  
z The physical conversion of the CAN signal will be rounded to a length of 16-bit resolution for all data.  The GX-1 CAN requires four 

contiguous data samples for each CAN data packet.  Data samples beginning or ending with less than four contiguous data samples 
will be invalidated during recording.  

z When the CANdb file is specified for recording by using the GX Navi, the message name and other information are automatically 
displayed, otherwise specify the CANdb file of the recorded CAN data at <CANdB file name>.  

 
 

7.1. Operations to Convert 

1. Run [AFCNEO.EXE] after installing PL-S1002CAN AFC NEO + CAN. 
 

2. <AFC NEO + CAN> is displayed when running the AFC NEO + CAN. 
 

 
 
 
 
3. The folder name and the file name of the source file are displayed at <Original file>.  
Click [Ref...] of <Original file> to select or change the source file to be converted.  
The <Select File> dialog is displayed to select the file.  Specify the file name to convert 
at <Output file>.  Select [CAN] or [CAN + DADiSP] at <Format type of output file>. 
Use [CAN+DADiSP] for the data recorded at the multi-sampling function of the GX-1, 
which up-samples the lower sampling data to the higher sampling data.  The recorded 
channel names are displayed at <Channel of original file>. 
 

4. At this example, the CAN channel “CH1_AR_GXCAN” is displayed at <Channel of 
original file>.  Double click the CAN channel to display <CAN DIALOG>. 
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5. Click [Reference] of <CANdb file name> to select the CANdb file to be used to refer 
the signal name when converting to the physical value.  Related information on the 
CANdb file are displayed at <Message name>, <Signals>, and others.  
 
 
 
 
 

 

 

 

 

 

 

 
 

6. Select the message name which contains the signal names to convert from the pull 
down list of <Message name>. 
 
 
 
 

 

 

 

 

 

 
 
 
 

7. Check the box left to the signal name to convert.  
 
 
 
 

 

 

 

 

 

 

 

 
 
 

8. Click [OK] to select the signal with check for conversion.  
 
 
 
 
 

 

 
 

9. Select the necessary CAN signals and analog channels to load to <Channel of 
output file>.  Maximum signals and channels which can be processed is 128 total.  
 

10. Click [CONVERT] to start conversion. 
（An extensive time may be required depending on the data file size to be processed.） 
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Note: 
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